6B HP Color LaserJet 4600 Printer

6B.1 Overview

This appendix is designed to provide maintainers with the information necessary to support the HP Color LaserJet 4600 Printer.  This appendix identifies the printer’s Line Replaceable Units (LRUs) as well as the LRU’s controls and indicators.

The OASIS Flight Data Server Subsystem equipment includes a HP Color LaserJet 4550N Printer or a HP Color LaserJet 4600 Printer, both support printing high quality color graphics on plain copier-grade paper for the AFSS Workstation Subsystem.  The HP Color LaserJet 4600 comes standard with 96 MB RAM and an HP JetDirect 615 print server Enhanced Input Output (EIO) network card for connecting to a network.  For further detailed information on the Color Printer XE "Color Printer" , refer to the Hewlett Packard Color LaserJet 4600 Printer User Manual.

A front view of the HP LaserJet 4600 Printer is illustrated in Figure 6B-1.
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Figure 6B-1.  HP LaserJet Printer – Front View

6B.2 HP Color LaserJet 4600 Printer LRUs

The HP Color LaserJet 4600 Printer LRUs and consumables are described in Table 6B-1.

Table 6B‑1.  HP LaserJet 4600 Printer LRUs and consumables

	Item
	Description

	Color Printer
	HP Color LaserJet Printer 4600

	Black Cartridge
	Black Toner Cartridge

	Color Cartridge
	Cyan

Magenta

Yellow

	Drum Kit
	

	Transfer Kit
	

	Fuser Kit
	


6B.3 HP Color LaserJet 4600 Printer Controls and Indicators

The HP Color LaserJet 4600’s front panel controls and indicators are shown in Figure 6B-2 and described in Table 6B-2.  A rear view of the printer is illustrated in Figure 6B-3.

CAUTION:  If needing to ship the printer, remove the toner cartridges and imaging drum before shipping.

6B.3.1 Controls and Indicators

Front View

The front panel controls and indicators are shown in Figure 6B-2 and described in Table 6B-2.
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Figure 6B-2.  HP LaserJet 4600 Front View Controls, Indicators

Table 6B‑2.  HP LaserJet 4600 Printer Front View Controls and Indicators

	Item
	Description

	1
	Control Panel

	2
	Top Cover.

	3
	Front Cover

	4
	500-sheet paper feeder (Tray 2)

	5
	250-sheet output bin

	6
	On/Off Switch

	7
	Tray 1 (front cover open)


Rear View

Figure 6B-3 illustrates the rear view of the HP LaserJet 4600 printer.  Table 6B-3 describes the labeled parts.
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Figure 6B-3.  LaserJet 4600 Printer Rear View

Table 6B‑3.  LaserJet 4600 Printer Rear Controls and Connections

	Item
	Description

	1
	250-sheet output bin

	2
	On/Off Switch.

	3
	Optional 500-sheet paper feeder

	4
	EIO port (total of 3)

	5
	Fast Infrared (FIR) connection

	6
	Parallel cable connection

	7
	Power Cord connector/receptacle.


Control Panel

The Front Control Panel controls and indicators for the HP LaserJet 4600 printer is shown in Figure 6B-4 and described in Table 6B-4.
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Figure 6B-4.  LaserJet 4600 Printer Front Panel Controls and Indicators

Table 6B‑4.  LaserJet 4600 Printer Controls and Indicators– Front View

	Item
	Description

	1
	Ready LED

On
	Printer is online (able to accept and process data.

	
	Off
	Printer is offline or is turned off

	
	Flashing
	Printer is attempting to stop printer and go offline.

	2
	Cancel Job.  When pressed cancels and halts the current job in progress, clears paper from the printer, clears any continual errors associated with the halted job, and is used to override a non HP print cartridge.

	3
	Pause/Resume - Temporarily stops and restarts printing, and exits all menus.

	4
	Control Panel Display – Divided into four areas.  

Message Area - provides information about the printer and print jobs.  Graphics illustrate levels of supplies, the locations of paper jams, and job status.  Menus give access to printer functions and detailed information.

Prompt Area – provides instructions based on the desired activity.

Supplies Gauge Area indicates the amount of printer color media is available.  Each color cartridge is represented directly below the applicable gauge.

Color Cartridge Area  - from left to right the cartridge colors are black, magenta, yellow and cyan. The gauges above each color represent the amount of color remaining.

	5
	Select.  Makes selections and resumes printing after continual errors..

	6
	Help.  Provides animated graphics and detailed information on printer messages or menus..

	7
	Attention LED

On
	A critical error has occurred.  Printer requires attention..

	
	Off
	No conditions exist that require attention..

	
	Flashing
	An error has occurred.  Printer requires attention..

	8
	Data LED

On
	Processed data is present in the printer, but more data is needed to complete the job.

	
	Off
	Printer is not processing or receiving data.

	
	Flashing
	Printer is processing and receiving data..

	Arrows
	Navigates menus and text, and increases (Up) or decreases (Down) the values of numerical items in the display

The Back Arrow (points left) Navigates backward in nested menus, or quits menus or help.


6B.3.2 Setup/Configuration

The Color Printer configuration and setup parameters can be set or changed through the Control Panel Menus.  A Menu Hierarchy is provided to aid the user when navigating through the various Control Panel Menus.  The menu hierarchy is described below.  Each menu comprising the hierarchy is described in Table 6B-5.

Menu Hierarchy

The Menu Hierarchy is based on five major menus.  These menus are:

· Retrieve Job Menu

· Information Menu

· Paper Handling Menu

· Configure Device Menu

· Diagnostic Menu

Table 6B‑5.  HP LaserJet 4600 Printer Menu Hierarchy

	Menu Name
	Description

	Retrieve Job Menu
	The Retrieve Job Menu allows the user to view listings of all stored jobs.  The Retrieve Job Menu consists of the following sub-menus:


A list of stored jobs

	Information Menu
	Use the Information Menu to access and print specific printer information. The Information Menu consists of the following sub-menus:


Print Menu Map


Print Configuration


Print Supplies Status Page


Supplies Status


Print Usage Page


Print Demo


Print File Directory


Print PCL Font List


Print PS Font List

	Paper Handling Menu
	The Paper Handling Menu allows the user to configure input trays by size and type.  This menu can also be used to set default media size and type.  It is important to correctly configure the trays with this menu before printing for the first time.  The Paper Handling Menu consists of the following sub-menus:


Tray 1 Size


Tray 1 Type


Tray <N> Size      N = 2 or 3


Tray <N> Type     N = 2 or 3

	Configure Device Menu
	The Configure Device Menu allows the user to change the printer’s default printing settings, adjust the print quality, change the system’s configuration and I/O options, and reset the printer’s default settings.  The Configure Device Menu consists of the following sub-menus:


Printing


Print Quality


System Setup


I/O

Resets

	Diagnostic Menu
	The diagnostics menu allows the user to run tests that can help in the identification and eventual solutions to printer related problems.  The Diagnostic Menu consists of the following sub-menus:


Print Event Log


Show Event Log


PQ Troubleshooting

Disable Cartridge Check


Paper Path Test


Sensor Test


Component Test


Print/Stop Test


6B.3.2.1 To Access A Menu

1.
On the printer Control Panel, <Press> ( (Select).  Press the Up and Down arrow buttons to navigate the listings.  Stop when the desired menu name appears.

2.
With the desired menu name appearing in the listing  <Press> ( to activate the selection.

6B.3.2.2 To Activate a Sub-Level Menu

1.
On the printer Control Panel, <Press> ( (Select).  Press the Up and Down arrow buttons to navigate the listings.  Stop when the desired menu name appears.

2.
With the desired menu name appearing in the listing  <Press> ( to activate the selection.

3.
Press the Up and Down arrow buttons to navigate the sub-menu listings.  Stop when the desired sub-menu name appears.

4.
With the desired sub-menu name appearing in the listing  <Press> ( to activate the selection.

6B.3.2.3 To print a Menu Map

A menu map presents a graphical representation of the printer’s menu hierarchy. A menu map can be useful when searching for specific menu and sub-menu selections.

1.
On the printer Control Panel, <Press> ( (Select).  Press the Up and Down arrow buttons to navigate the listings.  Stop when the “INFORMATION” menu title appears.

2.
<Press> the Up and/or Down arrows until “PRINT MENU MAP” sub-menu title is displayed.

3.
<Press> ( (Select).  to print the menu map.  After the process is completed, the printer will return to the READ state.

6B.3.2.4 To print a Configuration Page

Printing a printer Configuration page can help the user verify that the printer is configured properly.  This can be useful in troubleshooting printer problems.

1.
On the printer Control Panel, <Press> ( (Select).  Press the Up and Down arrow buttons to navigate the listings.  Stop when the “INFORMATION” menu title appears.

2.
<Press> the Up and/or Down arrows until “PRINT CONFIGURATION PAGE” sub-menu title is displayed.

3.
<Press> ( (Select).  to print the Configuration Page.  After the process is completed, the printer will return to the READ state.

6B.3.2.5 To print a Supplies Status Page

The supplies status page illustrates the remaining life for the following printer consumables and kits:

· Toner Cartridges (all colors)

· Drum Kit

· Transfer Kit

· Fuser Kit

It also lists useful printer information including the total number of pages printed (in monochrome and in color), the printer serial number, and the part numbers for the supplies.

1.
On the printer Control Panel, <Press> ( (Select).  Press the Up and Down arrow buttons to navigate the listings.  Stop when the “INFORMATION” menu title appears.

2.
<Press> the Up and/or Down arrows until “PRINT SUPPLIES STATUS PAGE” sub-menu title is displayed.

3.
<Press> ( (Select).  to print the Supplies Status Page.  After the process is completed, the printer will return to the READ state.

6B.3.2.6 To Automatically Set the IP Address for Network Communication

This feature is not currently available.

6B.3.2.7 To Manually Set the IP Address for Network Communication

The OASIS equipment uses common IP addressing schemes from site to site.  The first 3 fields of an IP Address represent a Site ID, and the last field is used to designate a specific piece of site equipment.  The IP Address for the Color Printer are designated as follows:

· IP Address  -  xxx.xxx.xx.11, where the x’s represents a Site ID.

Print a Configuration Page to check the IP Address of the Color Printer.  Refer to Appendix A for specific site and equipment IP address information.

Execute the steps below to manually set an IP address, subnet mask, and local and default gateway.

1.
<Press> ( to enter MENUS. 

2.
<Press> Down arrow to highlight CONFIGURE DEVICE 

3.
<Press> ( to select CONFIGURE DEVICE.

4.
<Press> Down arrow to highlight I/O

5.
<Press> ( to select I/O. 
6.
<Press> Down arrow to highlight EIO 1 

7.
<Press> ( to select EIO 1

8.
<Press> Down arrow to highlight TCP/IP

9.
<Press> ( to select TCP/IP

10.
<Press> Down arrow to highlight MANUAL SETTINGS

11.
<Press> ( to select MANUAL SETTINGS

NOTE: First of three sets of numbers is highlighted.  If there is not a number highlighted, a highlighted empty underscore appears.

12.
<Press> Down arrow to highlight IP ADDRESS

13.
<Press> ( to select IP ADDRESS

14.
<Press> Up and Down arrows as needed to increase or decrease the number for configuring the IP address.

15.
<Press> ( to move to the next set of numbers.

16.
Repeat steps 14 and 15 until the correct IP address is entered.

17.
<Press> Pause/Resume button to return to the READY state
6B.3.2.8 To Verify Printer Configuration:

To verify that the printer has been configured correctly, perform the following procedure from NT Server 1 or 2:

1.
<Select> Start>Settings>Printers
2.
<Select> the CPRINTER 4600  icon, then right mouse click and <Select> Properties
3.
<Click> on Print test page
4.
Did the test page print correctly? <Click> on YES or NO
5.
Close CPRINTER Properties
6B.3.2.9 To verify the IP Address and Network communications:

1.
At the BackUp NT Server use the Start button to <Select> Start>Programs>Command Prompt to open a DOS Window.

2.
At the “C:\>” prompt , <Type> ping xx.xxx.xxx.11 (where the x’s represents the Site address and .11 is the IP address for the Color Printer).


The system should reply a number of times with the correct IP Address.  If the system responds with a “timeout”, recheck the IP Address and the Network connections.

3.
Print a “Configuration Page” to verify the IP Address, if necessary.

6B.3.3  XE "Maintenance" Maintenance Procedures

This section contains the following three categories of Maintenance Procedures:

· Preventive Maintenance Procedures

· Remove and Replace the Printer consumables

· Remove and Replace the Printer. 

6B.3.3.1 Cleaning the Printer
To maintain high print quality and performance, thoroughly clean the printer an the paper handling accessories:

· Whenever the toner cartridge is changed (run a few pages through afterwards). 

· After printing approximately 8,000 pages for cyan, magenta, and yellow (CMY) and 9,000 pages for black. 

· Whenever print quality problems occur.

Clean the printer and the paper handling accessories in accordance with Table 6B-6
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WARNING:  Before beginning these steps, turn off the printer and unplug all power cords to avoid shock hazard.  Use caution when cleaning around the fusing assembly area - it may be hot.

CAUTION: To avoid permanent damage to the toner cartridge, do not use ammonia-based cleaners on or around the printer.  Do not touch the transfer roller.  Skin oils on the roller can reduce print quality.  If toner on clothing, wipe it off with a dry cloth and wash in cold water.  Hot water sets toner into fabric. 

Table 6B‑6.  Printer and Paper Handling Accessories Cleaning

	Component
	Cleaning Method

	Outside Covers
	Use a water-dampened cloth. Do not use solvents or ammonia-based cleaners.

	Inside General
	With a dry, lint-free cloth, wipe any dust, spilled toner, and paper particles from the paper path area, the registration roller, and the toner cartridge cavity.

	Paper Pickup, Feed, and Separation Rollers
	Use a water-dampened, lint-free cloth.

	Separation Pad
	Use a dry, lint-free cloth.

	Registration Roller
	Use a dry, lint-free cloth.

	Transfer Roller
	Use a dry, lint-free cloth. Do not touch the roller with fingers.

	Fuser
	Use a water-dampened, lint-free cloth.

	Printer
	Cleaning cloth that is provided with the printer.


6B.3.3.2 Printer Consumable Items Replacement

Table 6B-7 lists the replacement intervals for printer consumable items and the control panel messages that display when each item needs to be replaced.

Table 6B‑7.  Printer Consumables Items Replacement Schedule

	Consumable
	Printer Message
	Page Count
	Approximate Time Period**

	Black Toner Cartridge
	REPLACE BLACK CARTRIDGE
	9,000 pages*
	3 months

	Color Cartridges
	REPLACE <COLOR> CARTRIDGE
	8,000 pages*
	2.7 months

	Image Transfer Kit
	REPLACE TRANSFER KIT
	120,000 pages***
	41  months 

	Image Fuser kit
	REPLACE FUSER KIT
	150,000 pages ***
	50 months 


*
The approximate average A4/letter-size page count is based on 5% coverage of individual colors. Usage conditions and print patterns may cause results to vary. 

**
Approximate life is based on 3,000 pages per month. 

***
Usage conditions and print patterns may cause results to vary.

6B.3.3.3 Locating Consumable Items

The locations of the consumable items are shown in Figure 6B-5 and described in Table 6B-8.
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Figure 6B-5.  Consumable Items Location

Table 6B‑8.  Consumable Items Location Description

	Item
	Description

	1
	Fuser

	2
	Print cartridges

	3
	Transfer unit


6B.3.3.4 Managing the Print Cartridge

Do not remove the print cartridge from its package until it is needed.  It is best to limit the cartridge’s exposure to light.

The life expectancy of a print cartridge depends on the usage patters and the amount of toner that print jobs require.  The print cartridge life can be checked using the printer control panel.  The steps to check the cartridge’s life are listed below.

While at the printer control panel:

1.
<Press> ( to enter MENUS. 

2.
<Press> Down arrow to highlight INFORMATION. 

3.
<Press> ( to select INFORMATION.

4.
<Press> Down arrow to highlight PRINT SUPPLIES STATUS PAGE.

5.
<Press> ( to print the supplies status page.

6B.3.3.5 Changing The Print Cartridge

When a print cartridge approaches the end of its useful life, the control panel displays a message recommending that a replacement be available.  The printer can continue to print using the current print cartridge until the control panel displays a message instructing to use the replacement cartridge.

The printer uses four colors and has a different print cartridge for each.  Black (K), magenta (M), cyan (C), and yellow (Y).

Replace a print cartridge when the printer control panel displays a REPLACE <COLOR> CARTRIDGE message.  The control panel display will also indicate the color that should be replaced.  The steps to change a print cartridge are outline below.
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	1. List the printer’s top cover

2. Pull down the front cover and transfer unit.

3. Remove the used print cartridge from the printer.
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	4. Remove the new print cartridge from the bag.  Place the used print cartridge in the bag for recycling.

5. Grasp both sides of the cartridge and distribute the toner by gently rocking the cartridge from side to side.

6. Remove the orange shipping lock from the new print cartridge.  Discard the lock.

7. Remove the inside sealing tape by breaking the orange tab on the end of the new print cartridge and pulling the tape completely out.  Discard the tape.

8. Align the print cartridge with the tracks inside the printer and insert the cartridge until it is completely seated.

NOTE: If a cartridge is in the wrong slot, the control panel will display the message INCORRECT COLOR. 

9. Close the front cover and then close the top cover.  After a short while, the control panel should display READY.

10. Installation is complete.  Place the used print cartridge in the box in which the new cartridge arrived.

11. If a Non-HP print cartridge, check the control panel for further instructions.


Remove and Replace LRUs

	  See Another Document
	For the interconnect information on LRUs, use the OASIS Site Drawing Package for your location.


6B.3.3.6 To remove and replace Color Printer

1.
Ensure that the Printer Power is Off and remove the power cable from the back of the unit.

2.
Remove the paper from the paper trays and set them aside.

3.
Remove the Toner Cartridges and set them aside.

4.
Remove the Ethernet (Network) Cable from the back of the Printer.
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WARNING:  The Color Printer unit weighs approximately 80 lbs.  Removing the Printer requires a four person lift.

5.
Unpack the replacement Printer and Ensure that it contains an Ethernet Network Card.  If not, remove the Network Card from the old Printer and replace it on the new printer, using the Remove and Replace the Ethernet Network Card procedure.

6.
Install the Ethernet Cable onto the replacement Printer.

7.
Install the Toner Cartridges removed from the old Printer.

8.
Add paper to the trays and install them.

CAUTION:  To protect the Printer from a power surge, make sure the power switch is in the Off position before plugging in the power cord.

9.
Connect the Power Cable onto the back of the replacement Printer and  power-on the replacement unit.

10.
Perform the Printer Tests and the Operational Verification.  The Printer should already be configured from the Depot.  If any problems are encountered attempt to print a “Configuration Page” to verify the Printer setup.

Testing/Verification

Operational Verification

To ensure that the Color Printer is operational, print a Configuration Page.  To check the operation of the printer through the LCN, use WIND to print a weather image from an AFSS Workstation.

6B.3.3.7 To test the Color Printer using the Network

1.
Ensure that the Printer is ON and that the READY message is displayed on the control panel. 

2.
At an AFSS Workstation, <Double-click> the WIND icon to open the WIND application.

3.
When the WIND window is displayed <Click> on the File menu and <Select> Current Products to display the Current Products dialog box.

4.
Within the Currents Products dialog box, <Select> a Class and Clipboards then <Click> the Display button to open a window and display a Weather Graphic product.

5.
When a Weather Graphic product is displayed, <Click> the File menu and <Select> Print to display the Print dialog box.

6.
Within the Print dialog box, <Click> on the  (Down arrow) of the Name drop-down list box and <Select> cprinter 4600 to choose the Tektronix Color Printer.

7.
With cprinter as the selected printer, <Click> the OK button to print the Weather Graphic product to the Color Printer.

8.
Ensure that the Graphic was printed to verify that the Color Printer is operational using the LCN.

 XE "Fault Isolation" Fault Isolation Checklist

As an aid in troubleshooting refer to Table 6B-10 which lists the normal problems /Error Message and solutions.

Table 6B‑9.  Troubleshooting Checklist

	Problem or Error Message
	Solution

	The control panel display is blank
	Make sure the printer’s power switch is On.

The printer may be in PowerSave mode.  <Press> GO to check.

Make sure all power cables are securely attached and plugged into a grounded power outlet.  Verify that the short cable on the back of the duplex printing accessory is connected to the printer and that the power cord is connected correctly between the optional duplex printing accessory and the outlet.

	The control panel displays “OFFLINE”.
	<Press> PAUSE/RESUME.

	Can not print from the computer using a parallel cable.
	The cable might be bad or installed incorrectly, or might be too long.  Remove the cable and reconnect it, making sure it is securely connected.  Try another bi-directional parallel cable  (IEEE-1284 compliant) with a “C-size” connector under 10 m  (32 ft) in length.

There may be a bad port on the computer or printer.  Try using a different port, or, if possible, a different computer or printer to help isolate the problem.

	Cannot print using a sharing (switchbox) device.
	Remove the sharing device to isolate the cause of the problem.  Test the printer using a cable connected directly from the computer to the printer.

	Random “garbage” characters are printing.
	The cable might be bad or installed incorrectly, or might be too long.  Remove the cable and reconnect it, making sure it is securely connected.  Try another bi-directional parallel cable  (IEEE-1284 compliant) with a “C-size” connector under 10 m  (32 ft) in length.

There may be a bad port on the computer or printer. Try using a different port, or, if possible, a different computer or printer to help isolate the problem.

	Control panel displays “13.X PAPER JAM”.
	Paper may be jammed in one of several locations.  Clear all jams. 

Make sure packing spacers are removed from all media trays.

	Control panel displays an error message.
	Turn the printer Off and back On.

	Cannot find the printer in the network 

– OR –

The Configuration Page indicates an “I/O CARD NOT READY” message. 
	Verify cabling connections.

Ensure all configuration parameters are correct.


Testing Procedures

6B.3.3.8 To “ping” the Color Printer

To check the Ethernet Port and the cable to the Color Printer, ping the printer from the Maintenance Position.

1.
At the Maintenance Position (NT Server 2),  <Click> the Start button and select Start>Programs>Command Prompt to open the Command Prompt dialog box.

2.
At the “C:\>” prompt , <Type> ping xxx.xxx.xx.11 (where the x’s equals the site IP address and .11 represents the color printer IP address) to ping the Color Printer.


If the Ethernet Port and the connection to the device under test are operational., the system should respond three times with the correct IP Address and the number of bytes transferred.


If the system responds with a “timeout”, recheck the device’s IP address and the network connections.

3.
Upon the completion of using the Command Prompt window,  <Type> exit at the “C:\>” prompt to return to the Windows Desktop.
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